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As both a comprehensive textbook and workbook, Learning MicroStation VBA serves as an
integral part of Bentley Institute programming courses. Whether you are a MicroStation user who
simply wants to make your job easier or an experienced programmer who wants to master the
nuances of MicroStation VBA, this book is an invaluable resource for learning MicroStation
VBA.VBA instruction specifically for design professionals :- Learn to create short-cuts and
standards- Requires no programming experience- Many working examples with source code-
Power tips for experienced programmers
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Incorporated 685 Stockton Drive Exton, PA 19341ForewordJohn Gooding of Bentley Systems,
Inc.MicroStation VBA, the MicroStation V8 implementation of the Microsoft Visual Basic for
Applications (VBA) engine, provides MicroStation users and developers with a large number of
capabilities -from easy customization to tight integration with other Windows applications. With
VBA, users can customize MicroStation to automate repetitive tasks that are specific to their
needs.Many users have discovered the simplicity of using VBA to make their jobs easier. The
ability to use a standard user interface, the advantage of using one of the most popular
programming languages in the world, and the ease of connecting and communicating with
Microsoft Office and other applications are just some of the many things that VBA
provides.While MicroStation VBA is popular, you might be among those who are hesitant -
perhaps even a bit leery - to explore programming in MicroStation. You shouldn’t be. VBA is the
easiest environment to explore programming, and Learning MicroStation VBA is an excellent
guide to help you do it yourself.Too often, one-size-fits-all manuals lack either the appropriate
grounding material a new user needs or the in-depth technical information experts require.
However, Learning MicroStation VBA accomplishes the rare feat of serving both novice and
expert users equally well. With the benefit of Jerry Winters’ broad VBA expertise and his
knowledge of MicroStation, that’s exactly what this comprehensive text accomplishes.The
introductory chapters thoughtfully and thoroughly step new users through the basics of Visual
Basic for Applications. From his detailed review of VBA’s Integrated Development Environment,
through his careful consideration of how and when to use forms and class modules, to his
comprehensive explanation of object models, Jerry ensures that novice users not only have a



how-to guide for working with VBA, but they can also benefit from his insight into how VBA tools
can be best applied to create professional applications for MicroStation.Expert VBA
programmers will likewise find Jerry’s book an invaluable reference tool -- one that will help them
exploit what VBA has to offer. Jerry’s overview of XML and the Windows API in MicroStation
VBA, for instance, are sure to improve any programmer’s mastery.But for the masses of
MicroStation users, this book should help you finally put your programming fears to rest. Within
these pages, you have all you need to start programming in MicroStation and automate your
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pathReturning Function ValuesWindows API CallsDistributing VB.NET
ApplicationsReviewAdditional SourcesIndexIntroductionLearning MicroStation VBA provides an
in-depth tour of one of MicroStation’s most powerful customization abilities. The book starts by
supplying the foundation for understanding VBA basics and then shows how to apply the
fundamentals to real-world situations.Learning MicroStation VBA provides full coverage of the
VBA subject -taking you through the basics like the editing environment, modules, visual
interface, and MicroStation object model through advanced topics like the Windows API,
interacting with other applications, and Visual Basic, among many other things.Whether you are
a MicroStation user who simply wants to make your job easier or an experienced programmer
who wants to master the nuances of MicroStation VBA, this book is an invaluable resource for
learning MicroStation VBA.The following type styles are used in this book to distinguish various
text:Filename or URLMenu and menu itemsFunctionObjectFunctionIndexVariableKeyboard
keyACCOMPANYING CD-ROMThe accompanying CD includes all source code referenced in
each chapter of the book. The CD also includes procedures, and addenda to the book as well as
a comprehensive Object Model listing and other example files such as V8 DGN files, Microsoft
Excel spreadsheets, Microsoft Access databases, and more.MYSELECT CDBentley SELECT
Subscribers can order the supporting files through the MySELECT CD program. MySELECT CD
allows you to select the Bentley software or documents you need and have a CD delivered to
your door.To become a Bentley SELECT Subscriber, go to . Bentley SELECT is a subscription
program that features product upgrades and updates.ABOUT THE AUTHORJerry Winters
began his CAD career as many have, at the bottom of the totem pole, drafting eight hours a day.
It didn’t take long for him to discover that in many situations, the computer could complete
repetitive tasks much faster than he could. So, he began writing programs that not only simplified
the drawing creation process but significantly decreased the amount of time needed to create
drawings. Rather than wasting the time saved by his programming efforts, Jerry used the new
found time to write more programs until he stopped using CAD software and began customizing
CAD software on a full-time basis. So, for the past 15 years, Jerry Winters has been customizing
CAD software and teaching others to do the same.Whether it’s on stage or in the written word,
Jerry brings occasionally complex programming topics down to the level of the average CAD
user (in part because he considers himself an average CAD user). His extensive knowledge of
Visual Basic programming is complimented with Active Server Page development, database
programming expertise, and the occasional creation of Java applets for graphically-rich web-
based development.This is his first book on customizing MicroStation with VBA and he
experienced one difficulty throughout the entire book. “There is just so much that can be done in
MicroStation’s VBA environment, it is difficult to know what to include and what to shelf for a later
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Jennings, Drew Knox, Maureen Rhoads, and Christopher Rogers, without whom this book
would have never gotten off the ground.Furthermore, I would like to thank the Bentley Institute
for affording me the opportunity to write about MicroStation’s implementation of VBA. I hope the
lessons learned in this book will be as rewarding to the reader as they have been for me.1
Introducing VBA“LET’S START AT THE VERY BEGINNING. IT’S A VERY GOOD PLACE TO
START.” What is VBA? Why should we learn it? When should we use it? How do we use it? What
does it look like? These are five very good questions and they deserve answers.WHAT IS VBA?
VBA is an abbreviation for Visual Basic for Applications. Microsoft licenses VBA to companies
such as Bentley Systems, Inc., so users can customize the company’s software. Then,
companies that develop world-class software, such as MicroStation, can give their customers
the best set of tools available. These companies know that one way to accomplish this goal is to
empower customers to modify and personalize their software to meet individual needs.WHY
LEARN VBA?Learn VBA to rapidly develop programs that meet your individual needs. Much of
what you learn in MicroStation’s VBA environment can be used in other VBA environments. The
first two-thirds of the VBA abbreviation is “VB.” Visual Basic includes both the Visual Basic
programming language and its programming environment. “A” finishes up the final third of VBA.
The “A” is the Application-specific Objects and Application Programming Interfaces (APIs).If we
think of VBA as being two-thirds Visual Basic and one third Application, we could state that two-
thirds of everything you learn in this book is directly applicable to other VBA environments. For
example, if you learn MicroStation VBA, you would be 2/3 of the way to knowing Microsoft Excel
VBA. And this is not far off. So, in addition to being able to customize MicroStation to meet your
needs, learning VBA allows you to leverage other VBA-enabled applications.WHEN SHOULD
YOU USE VBA?Only under the direct supervision of an adult?Between the hours of 8 AM and 5
PM?Holidays? Weekends?The real question you should be asking yourself is, “Can the program
I need to write be written in VBA?” If the answer to this question is YES, then it should probably
be written in VBA. And as you learn more about VBA, more and more often the answer to this
question will be YES!HOW DO WE USE VBA?MicroStation VBA programming is stored in files
with an .mvba extension. To run any of the code in one of these MicroStation VBA files you must
first load the file. Before we go any further, let’s create a new drawing file named
Introduction.dgn. Go to the MicroStation menu Utility < Macros < Project Manager to open the
Project Manager.We use the Project Manager to begin new VBA projects and open existing VBA
projects.In this dialog box, click the Load Project button. Now, browse to the CD included with
this book for a folder named “MVBA Files”. In this folder you will find a file named
Introduction.mvba. Select this file and click the OK button.This loads the .mvba file into
MicroStation and displays it in the VBA Project Manager.Opening an MVBA file does not close
the Project Manager. The Project Manager remains open until you click the Close button in the
upper right-hand corner of the dialog box.Now that we have loaded an .mvba file, we can run
some code. How do we do it? There are a few ways. Let’s begin by running code from within the
VBA Project Manager. If the VBA Project Manager (VBAPM) is closed, follow the instructions



above to re-open it. Make sure to load the Introduction.mvba file. In the VBAPM, select the VBA
Project Introduction.mvba. Now look at the top of the VBAPM for a triangle that looks like the
play button on a VCR. This is the Run Macro button.When you click it, the Macros dialog box
opens, which allows you to select which macro (procedure or function) you want to run.Select
ProcedureA from the list of macros and click the Run button. The macros dialog box closes and
a diagonal line is drawn in the active model. ProcedureA draws a line from (0, 0, 0) to (10, 10, 0)
in the active file. If the macro is run and the line is not visible, use the Fit View button to zoom the
active view to display all of the contents of the file.Remember, the steps to running an MVBA
macro are:Load the MVBA file using the VBAPM (VBA Project Manager).Select the project in
the list of projects.Click the Run Macro button in the VBAPM, or click the MicroStation menu
Utilities > Macro > Macros, or hold down the <ALT> key on your keyboard and press <F8>
key.It’s a three-step process. Of course, if the .mvba file is already loaded, You do not need to
load it each time you run the macro. You can run a specific macro by using one of three methods
described above in Step 3.You have just run a macro using the VBAPM. Now run one by using
the <ALT+F8> keyboard shortcut. Hold down the <ALT> key and then press the <F8> key to
display the Macros dialog box. Select ProcedureC from the list and click the Run button.
ProcedureC draws a square using lines from (0, 0, 0) to (10, 0, 0) to (10, 10, 0) to (0, 10, 0) and
finally back to (0, 0, 0).That’s all there is to running a MicroStation VBA macro. Load it and run
it.WHAT DOES VBA LOOK LIKE?Here is the VBA code behind that macro:Sub ProcedureA()
'******** '* This Procedure draws a line from (10, 10, 0) to (30, 10, 0) '******** Dim Start Point As
Point3d Dim End Point As Point3d Dim My Line As LineElement StartPoint.X = 0 StartPoint.Y
= 0: StartPoint.Z = 0 EndPoint.X = 10: EndPoint.Y = 10: EndPoint.Z = 0 Set MyLine =
CreateLineElement2(Nothing, _ StartPoint, EndPoint) ActiveModelReference.AddElement
MyLineEnd SubVBA Projects are broken up into blocks of code called procedures, functions,
and events. Each block of code has a name. The procedure shown above is named ProcedureA.
Comments in the code begin with an apostrophe. Everything after the apostrophe is part of the
comment. Variables are declared with 'Dim' statements and are then assigned values or set to
objects. Code in procedures, functions, and events runs from top to bottom. Together we will
write a large number of functions and procedures as we study MicroStation VBA.Back to the
code in ProcedureA. It does not have a graphical user interface — it is just code. Writing code is
one part of VBA development.The other part of VBA development is the graphical user interface
(GUI), such as buttons, text boxes, and labels.Some of the applications we write will have no
GUI, but we will also explore the visual side of Visual Basic.REVIEWVBA projects are contained
in .mvba files. Each file contains code and can also contain graphical user interfaces. Load and
unload VBA projects using the VBA Project Manager. After the code is written, You run VBA
projects and the code they contain by using the MicroStation menu Utilities > Macro > Macros...
or by pressing <ALT+F8> on the keyboard.Learning VBA is very much like learning a new
language. It requires patience and time. Keep this in mind as we continue to study together.2
The VBA Project ManagerYou have already seen how to display the VBA Project Manager.



Remember, go to the MicroStation menu Utilities > Macro > Project Manager. We used the
Project Manager to load a VBA project and run a couple of macros contained in that project. Lets
take a more comprehensive look at what the Project Manager can do for us. The Project
Manager gives us the ability to load existing VBA projects. The Project Manager allows us to run
the procedures and functions of projects that have already been loaded. Start new VBA projects
using the Project Manager. Unload VBA Projects that are already loaded. Save loaded VBA
Projects to a new location and/or a different file name. Enter the Visual Basic Editor from the
Project Manager. Record macros from the Project Manager. Auto-Load VBA Projects so projects
are loaded each time MicroStation is started.We can use the MicroStation menu to display the
VBA Project Manager or we can hold down the <ALT> key and press the <F8> key to display the
macros that are loaded and are ready to be run.We need to be careful when discussing the VBA
Project Manager. The term ‘Project Manager’ is so generic it could be confused with other
products or functionality. For brevity we will refer to the VBA Project Manager as the VBAPM
from time to time throughout this book.Now that we have identified the VBAPM’s functionality in
general it is time to examine it in greater detail.VBA PROJECT MANAGER
FUNCTIONALITYThe following graphic shows the VBAPM with its elements identified with
leader lines. We will refer to the image during the remainder of this chapter.ABegin a New VBA
ProjectYou are prompted for the location of the new .MVBA file and for its name.BOpen an
Existing VBA ProjectSelect an existing .MVBA file to load into the current session.CClose VBA
ProjectThis button is enabled only when an existing project is selected.DSave Project AsWhen
an existing project is selected, you can save it to a new location and/or a different file
name.EDisplay the VBA EditorAll saved VBA projects and new projects are edited from within
the VBA Editor.FRun MacroClick this button to display the Run Macro dialog box where you
select and execute specific macros.GRecord MacroEnabled when an existing project is
selected. When activated, activities in MicroStation are recorded to a macro in the selected
project.HStop Recording MacroEnabled only when actively recording a macro. When stopped,
the macro is placed in the selected VBA Project under the name "Macro1", "Macro2", "Macro3",
etc. The Macro Recorder automatically names the macros. You can rename recorded macros in
the VBA Editor.JPause Recording MacroPauses the recording of a macro and toggles between
Pause / Resume Recording.KAuto-LoadSets a specific VBA project to automatically load each
time MicroStation is opened. When you click in the column, a checkmark indicates the file is set
to Auto-Load.We have just identified ten things that you can do directly from within the VBA
Project Manager. One of these is “Run Macro” which, rather than actually running a macro,
displays the Macros dialog box.MACROS DIALOG BOXWe use the Macros dialog box to select
a macro to run but we can do far more in this dialog box than just running a macro. We can “Step
Into” it.Step Into executes the macro in debug mode stepping through the code one line at a time
so we can see how the code is executing, what values are stored in variables, etc. It is one of the
best features of VBA, whether you are a novice programmer or a seasoned developer.The Edit
button takes us into the VBA Editor window with the cursor on the top line of the selected



Macro.The Delete button deletes the selected Macro from the VBA Project. This is a very
dangerous button. After all, there is no Undo button displayed in this dialog box. Is there? Use
with care.Macros in: lists VBA projects. If you select <All Standard Projects>, the Macro list
displays all executable macros from all loaded VBA Projects. Selecting a project filters the
Macros list to display only those in the selected project.The Description area allows us to type in
a description for a selected macro. This is a nice feature because we are given the ability to
provide more information than by using the macro name only. For example, we do not need to
name a macro, Draw_A_Line_From_0_0_0_to_10_0_0. We can name it ProcedureA and enter
a description in the Macros dialog box.We have covered every button in the Macros dialog box
except for one, the button that is grayed out in the image above. You use the Create button to
create new Macros. It’s simple. Here’s how it works:As you select macros in the Macros list, a
TextBox just above the list box displays the macro selected name. If you change the text in the
TextBox to a macro name (Procedure name) not already shown in the Macros list box, the
Create button is enabled to begin a new macro with the name specified. So, if you type
ProcedureA_1 into the TextBox and click the Create button, a new Procedure named
ProcedureA_1 is created. Of course, no code is entered into the procedure after it is created.
That is our job. We can now select ProcedureA_1 from the ListBox, click the Edit button, and go
into the new procedure in the VBA Editor to begin writing code.REVIEWThe VBA Project
Manager is useful for performing a number of tasks. Among them are: To load and unload VBA
projects (MVBA files). To save existing VBA projects to new files and locations. To begin new
VBA projects. To record macros into existing VBA projects. To use Auto-Load to automatically
load VBA projects within the VBAPM. To enter the VBA Editor from within the VBAPM.3 The
VBA IDEOpen the VBA IDE PDQ!!! Yes, the IDE is WYSIWYG. GM?Translation: Open the Visual
Basic for Applications Integrated Development Environment Pretty Darn Quick!!! Yes, the
Integrated Development Environment is “What You See Is What You Get”. Got Milk?The VBA
IDE is where we do our VBA programming work. As with most Windows programs, the VBA IDE
is composed of three elements: Menus Toolbars WindowsMENUSNearly all Microsoft Windows
applications utilize Menus to issue commands. Many menu items have shortcuts. For example,
holding down the <CTRL> key and pressing the <P> key does the same thing as selecting File >
Print from the menu. Whether you click your mouse or use the associated shortcuts, it is helpful
to know what a menu item does. Let’s look at the menu items that are available in VBA.File Menu
Import File imports existing form (.frm), module (.bas), and class (.cls) files into our project.
Export File exports forms, modules, and classes from our project to their own .frm, .bas, and .cls
files. After these files have been exported, they can be imported into another project. Remove
removes forms, modules, and classes from our project. When we attempt to remove an element
from our project we are asked if we want to export it (save it) first. Print allows us to print code
and/or forms. Close and Return to MicroStation hides the VBA environment and gives
MicroStation focus.Edit Menu Undo and Redo are standard Windows menu items. Cut, Copy,
and Paste perform standard Windows Clipboard operations. Clear deletes selected text or



objects. Select All selects all text when in a Code window or all controls when in a User Form.
The Find, Find Next, and Replace menu items perform standard Find and Replace functions.
Indent indents the selected code by one tab to the right. Outdent (is Outdent a real word?) shifts
the selected code by one tab to the left. List Properties/Methods displays the Properties/
Methods list. List Constants works with an API call that utilizes constants. A list of the applicable
constants is shown. To use Quick Info, set the cursor on a variable, an object, or an object’s
property or method and then click Quick Info to display the type of object or variable on which
the cursor was placed. Parameter Info displays information about the Method the cursor is over.
Complete Word shows the list of Constants and Methods in VBA so we can select something
from the list. Bookmarks sets and removes bookmarks in our code and moves from bookmark to
bookmark. A bookmark is a flag that lets you quickly jump to a line of code. Bookmarks are not
saved with .mvba projects.View Menu When looking at a user form, click Code to jump to the
code behind the form. Object displays the form associated with the code we are looking at. Click
on Definition when the cursor is over the item you want to look at to quickly display where the
variable is declared or the method is defined. Last Position moves the cursor to the previous line
of code the cursor was in. Object Browser, Immediate Window, Locals Window, Watch Window,
Call Stack, Project Explorer, Properties Window, and Toolbox display a window with the same
name. Tab Order displays the Tab Order properties of controls so we can see the order in which
controls receive focus when the user hits the Tab button in the form. Toolbars toggles the display
of the Debug, Edit, Standard, and User Form toolbars. Click on MicroStation to bring the
MicroStation window to the forefront.Insert Menu Procedure displays the Add Procedure dialog
box to begin new procedures. This dialog box is most useful for creating new Properties for
Class Modules. UserForm, Module, and Class Module inserts these new objects into our project.
One way to speed up our development is to reuse code that has already been written. If we
place code in ASCII Text Files, insert snippets into our project by clicking File and then selecting
the file to insert.Format MenuUse the Format menu to perform standard formatting when editing
a User Form.Debug MenuThe Debug menu allows us to perform debugging operations on our
code. We will cover this functionality in Chapter 9 “Standard VBA Calls”.Run Menu Run Macro,
Break into, and Reset code execution by using these menu items in the Run menu. Design
Mode is a standard VBA button that does nothing substantive in the MicroStation
implementation of VBA.Tools Menu References allows us to add a reference to existing DLLs
and type libraries. For example, if we want to work with Microsoft Excel, we can add a reference
to the “Microsoft Excel Object Library”. Doing so makes working with Excel in VBA very easy. By
default, 14 controls display in the toolbox for use in our forms. We can add more controls by
selecting the Additional Controls menu item. Macros displays the Macros dialog box where we
can create, edit, run, delete, and debug macros in our project. Change preferences such as font
size, tab width, and grid settings by clicking on Options. The Properties menu item displays the
properties for the active VBA project. In the image shown above, the project is named Default.
Digital Signature allows us to sign our VBA projects. This assures end users that the code they



are going to run is created by a specific company.Add-Ins MenuThird party developers can
create add-Ins for VBA. Add-In Manager displays the Add-In dialog box where we can set
properties for available add-ins.Since we will not be discussing Add-Ins anywhere else in this
book, here is a snapshot of the manager with an add-in that has been loaded. Add-ins can be
loaded based on the “Load Behavior” settings.Window MenuThese are the standard menu items
available in nearly every Microsoft Windows program.Help Menu We will cover Help issues in
the next chapter. One way to get there is by clicking the Microsoft Visual Basic Help menu item.
About Microsoft Visual Basic displays the About dialog box.TOOLBARSToolbars offer a very
quick way to issue a command. One click is usually all it takes to get things started. Compare
this with at least two clicks to issue the same command using a menu and we can instantly
double our CIP (Command Issuing Performance). As a general rule, all commands issued by
clicking on a toolbar icon can be issued from the menus.It can take a little while to become
familiar with toolbar icons. Until you learn what each icon does, hold your cursor over an icon to
see what the icon does.Standard toolbarThe Standard toolbar is very, very important. Why?
Because the only way to save the changes we are making in our VBA project from within VBA is
to click the Save button. We cannot Save changes by using the menu. We must use the Save
icon in the Standard toolbar. And please, please, please, my friend, save your project often.
There are few things worse than spending a couple of hours working on a project only to have
something silly like a power outage or a fatal error cause you to lose all of that work.Notice how
holding your cursor over an icon displays the icon’s tool tip.We could show each and every
button on every toolbar but that would be a bit of a waste because you can move your cursor
over the icons to see what they do.Edit toolbarThe Edit toolbar displays functionality found in the
Edit menu.Debug toolbarThe Debug toolbar displays the functionality found in the Debug
menu.UserForm toolbarThe UserForm toolbar exposes functionality found in the Format
menu.WINDOWSUse the toolbars and menu items to display and hide VBA windows. Let’s take
a look at the VBA windows we will be working with on a regular basis.Project ExplorerThe
Project Explorer displays the top-level objects in the loaded projects.In this project we have a
form named UserForm1, a module named Module1 and a class module named Class1. The
view shown uses folders to group the common types of objects.Click on the Folder icon in the
top of the Project Explorer to turn off Folders and display the objects in alphabetical order.Object
BrowserThe Object Browser gives us a way to explore the objects (classes) loaded into the
current VBA project. In addition to the objects themselves, we see a list of properties, methods,
and events associated with each object under the “Members” list. The gray area at the bottom of
the window gives us the declaration of the selected method, property, or event. We can display
All Libraries or select a specific library. We also have the ability to search the loaded libraries.We
will cover the Object Browser in more detail in the next chapter.Properties WindowObjects in
VBA have names. For example, this user form has the name UserForm1. We can use the
Properties window to change this forms name, color, and other properties. The Properties
window is used extensively when working with forms and controls on forms.Watch WindowThe



Watch window is a favorite among VBA developers. It allows us to watch the value of a variable,
object, or property. As we can see above, I added a watch to a variable named MyApp. This
variable points to the MicroStation Application. Take a look at all of the properties with which we
can work.Locals WindowThe Locals window looks a lot like the Watch window There is one
primary difference however. To look at items in the Watch window, you must add a watch to the
item. The Locals window automatically displays the variables declared in the active procedure or
function along with each variable’s type and value.Immediate WindowThe Immediate window
does a couple of things for us. First, it allows us to display text as our code executes. When we
use the following codeDim MyApp As Application Set MyApp = Application Debug.Print
MyApp.Captionthe caption of the MicroStation application is printed to the Immediate window.
For this reason, it is also called the Debug window.The other thing the Immediate window does
is it allows us to execute code immediately. For example, we can typeMsgBox "Learning
MicroStation VBA"in the Immediate window and press the <Enter> key. When we do so, a
MessageBox displays.Call Stack WindowAs we step through our code line-by-line or break into
our code as it is executing, the Call Stack window shows us where we are (the top line), where
we started (the bottom line), and how we got there (all of the lines in between). There are times
when one procedure calls another procedure which calls a function which calls a procedure.
Knowing how we arrived inside a procedure or function can help us debug it.Toolbox
WindowThe Toolbox window displays the standard controls that can be placed on our user
forms. It only displays when a user form is the active window in VBA. If we are working with a
user form and the toolbox is not visible, click on the Toolbox icon in the Standard toolbar or go to
the View > Toolbox menu to display it.All of the windows discussed so far are dockable except
for the Toolbox. This means they can be snapped to the bottom, top, right, or left window of the
VBA IDE. These windows’ dockable property is set in the Docking tab of the Options dialog box.
To view this, go to the Tools menu in VBA and select Options.If an attempt to dock a window
fails, look at the Docking property of the window in the Options dialog box and turn on Docking
for the specific window you want to dock. As with many applications, these windows are docked
by dragging the window to the edge where you want the window docked. They are un-docked by
dragging the window away from the edge where the window is currently docked.Other
WindowsThere are a couple of additional windows in VBA we should discuss. As we have
already discovered, VBA projects are composed of forms, modules, and classes. Each of these
elements has its own windows.A single CommandButton has been added to this form. This form
window allows us to place controls on it. Remember, the controls are placed from the toolbox to
the form.What happens when we are running this form and the user clicks the button? Code is
executed. Double-clicking the button takes us to Code window behind the form. Another way to
see the code is to right-click on the button and select View Code.This is the Click Event of
CommandButton1. View Code takes us to the default event of the control we right-click over. So,
here we can see the Click Event. Are there other events we can work with? How do we see them
and write code in them?Take a look at the top of the Code window. There are two ComboBoxes.



The left one contains the controls and objects available in this Code window. The right one
contains the events we can work with. Selecting an event from the right ComboBox takes us into
the code for that event.Open Module (Code Module) and Class Module windows by double-
clicking on their icons in the Project Explorer or by right-clicking on the icons and selecting View
Code. They look exactly like the Code window shown above.We have spent a few pages
discussing the VBA IDE. As we continue learning MicroStation VBA, we will discover other
facets of the IDE and get into more detail.REVIEWThe VBA IDE (Visual Basic for Applications
Integrated Development Environment) is where we do our programming, i.e. writing code and
creating user interfaces. As you become more familiar with this environment, you will be able to
develop your programs much more quickly.4 Finding HelpFinding help can be one of the most
difficult aspects of learning a new programming language. Why? If you have a question for
someone, you can converse with them until the question is clear. That’s easy. When learning
VBA, however, you don’t always know what to ask. For example you might ask, “How do I put
something on a form that forces a user to enter a numeric value?” If you could ask a VBA guru
this question, you will get a straightforward answer. Working through a Help file for the answer is
different. For starters, even if you know what to ask but you don’t know the correct terminology,
you won’t find the answer.Distressing? Yes. Frustrating? Definitely. The end of civilization as we
know it? No.This book is targeted toward helping you learn MicroStation VBA. It is filled with
code samples and explanations but it does not contain every answer to every possible question.
Here a few things that will provide help when you need it.In this Chapter: Terminology Help Files
The Net The Object BrowserTERMINOLOGYThingy. Dilly Whopper. Whatchamacallit. Gizmo.
Whether we are asking a person or a computer, these words will get us nowhere. How can we
get a little closer to the right keyword?Let’s begin by looking in VBA.Holding your cursor over a
variety of objects displays a Tool Tip. There is a ComboBox icon in the Toolbox. If we ask about a
ComboBox we are more likely to find answers than if we ask about a DropDown. Both
combinations of words may make sense to us, but using the correct name for the control gets us
closer to finding answers to our questions than using terminology that, although descriptive, is
not correct.Since the terminology used in VBA may be foreign to you when getting started, it is a
good idea to make notes or highlight areas of this book and other resources when you come
across a word or phrase you want to remember or that you may want to be able to find quickly at
a later date.For example, if you are asked to provide a string, you may produce a piece of flexible
material useful for restricting blood circulation in one’s index finger with the intent of reminding
you of something. As for me, I’m just as likely to forget the string is tied around my finger as I am
to forget why the string is there in the first place. What does this mean? Before long we are
collectively fingerless. Or is it finger-free? Digitless?What is a string when it comes to VBA? It is
a type of variable that can hold text, numbers, and other characters. “This is a test” is an example
of a string. Since the word string is very different when dealing with VBA when compared to
Benjamin Franklins experiments with electricity, highlighting the definition of a string type
variable in a book may be helpful.In addition to highlighting existing text, get out a pen or pencil



and write in the margins of this book.“Chicken Soup for the VBA Programmer.” “The VBA Word
of the Day” “The VBA Programmers Daily Calendar.” These products may not exist but they
could be very helpful. Why? Frequent and regular exposure reinforces retention.If your goal were
to obtain a dark tan, you would want regular exposure to the sun. If your goal were to bake
bread, it would be out of reach if you rarely stepped inside a kitchen. “Practice makes Perfect,”
“No Pain, No Gain,” and “If at first you don’t succeed, try, try again.” We have heard these
statements over and over again. Each of them reminds us that frequent and prolonged exposure
and practice is usually necessary for success in any endeavor. While you don’t need to write a
thousand lines of code every day to learn VBA terminology, 20 lines of code every day will do
more than 100 lines of code only on Monday mornings.If you expose yourself to VBA frequently,
the terminology becomes familiar and you will be in a better position to find the help you
need.HELP FILESOne way to display the VBA Help File is to go to the Help menu in VBA and
select Microsoft Visual Basic Help.It is filled with a large amount of information but also gives us
the ability to organize our own unique help file by using of the Favorites tab.So, you want a little
help with a ComboBox? Let’s begin in the Contents tab and drill down to the ComboBox starting
with the Microsoft Forms Reference.Contents tabIt may take a little digging to find what you are
looking for using the Contents tab but knowing the correct terminology is a big help. At the top of
many help topics, are links for “See Also,” “Example,” “Properties,” “Methods,” “Events,” and
“Specifics”. If you are looking for more explanations, “See Also” is very helpful. If you are looking
for code to copy and paste, “Example” is the link you want. For information about specific
Properties, Methods, and Events, click the appropriate link.The body of help topics often contain
hyperlinks to other topics and pop-ups to explain the highlighted text in greater detail.You can
print help Help topics by clicking the Print icon at the top of the file.Index tabThe Index tab
displays a different way to organize help topics. It works much like the index of a book. This is
another area where using correct terminology is very helpful. If you enter “string” in the keyword
textbox, you get a large number of linked topics. Enter “text” and you get a number of unrelated
topics (if we are looking for information on the String variable type) but also a link to the “String
data type.” So even if you don’t have the exact terminology, getting close to the correct word may
link you to the correct topic.Search tabUse the Search tab to enter a word or series of words to
search for in the help topics. It returns a list of all help topics containing the word(s) entered. For
example, if you enter “combobox,” you are returned a listing of 67 topics. Some topics are
properties such as “List Property”. Other topics are instructional, such as “Ways to put data in a
ListBox or ComboBox.” Keep in mind that most help topics are linked to related topics. So, we
could begin with a search for “combobox” and read far more than 67 topics by jumping to other
help topics.Favorites tabIf you find a particularly helpful help topic or one that was difficult to find,
add it to your Favorites. The “Current topic” text box displays the default topic title. Fortunately,
you can change this description to whatever you want it to say. For example, you could change it
to “ComboBox - Adding To the List.” Then click the Add button.Favorites is one of the best ways
to personalize the standard Visual Basic Help file. Sure, you can print out page after page after



page, use a highlighter and make a binder. That is a fine way to catalog what you have learned
and create additional reference material. But Favorites is a quick way to find ‘bookmarked’ topics
and jumps to linked topics. It also keeps the Copy and Paste functionality available.To sum up,
VBA stands for Visual Basic for Applications. Thus far in this chapter, we have been discussing
how to find help for the “VB” portion of VBA. What about the “A”? The Application? Good
question.Learning everything about the VBA programming language will give us some good
background but will not get us very far when attempting to interact with
MicroStation.McroStation VBA Help FileMicroStation has its own VBA Help file. It contains
MicroStation-specific help for VBA. Searching for the file ‘microstationvba.chm’ on your
computer should show us where it is and let you open it.One of the most helpful sections in the
MicroStation VBA help file is the Examples folder, which contains excellent explanations as well
as the code to perform specific tasks.Another excellent way to open the MicroStation VBA Help
file is to select a MicroStation-specific API call in the Object Browser or in our code and hit the
<F1> key on the keyboard.THE NETGot Net? gets us to Microsoft’s VBA web site. If this URL is
difficult to remember, you can also use , which contains links to white papers, Knowledge Base
articles, and other reference materials that comprise a wealth of information on VBA
programming and its associated topics. Although you are not likely to find much about
MicroStation’s VBA-specific implementation here, you will find many other examples on how to
accomplish specific tasks in the VBA environment.Google, Yahoo, and other search engines can
unlock the rest of the Internets VBA knowledge for us. Remember, there are a lot of
programming languages out there. A search for “Message Box” returns us a large number of
web pages to check out, but in addition to VBA results, we will get pages for C#, C++, Java,
JavaScript, Fortran, Pascal, and other languages.A quick trip to the Bentley web site and a
search for “vba” nets some good information as well. Why not go directly to the source?Among
the Bentley Discussion Groups we find Bentley.microstation.v8.vba. This is a good place to ask
questions. And who knows? As you become a VBA guru in your own right, you may be able to
help others by answering their questions in this Discussion Group.THE OBJECT BROWSERWe
talk to MicroStation through its Object Model. The top level of the MicroStation’s Object Model is
the Application Object. Using the Object Browser in VBA is a great help when you are trying to
discover something about an Object Model. As shown, you can restrict browsing to the
MicroStation DGN library so all MicroStation Classes show up in the ListBox on the left.
Selecting “Application” in the left ListBox displays its properties, methods, and events in the
listbox on the right side of the window.For example, if you have selected Application in the
ListBox on the left and want to do something with the active design file in MicroStation, click on
ActiveDesignFile in the right-hand ListBox. The description at the bottom of the Object Browser
tells us the ActiveDesignFile property of the Application Object returns a DesignFile object. We
can now select DesignFile in the Classes list (the listbox on the left) to see the Design File’s
properties, methods, and events in the Members list on the right.Selecting AddNewLevel in the
Members list shows that we need to supply a LevelName when using AddNewLevel. It also



shows that AddNewLevel returns a Level Object.One reason the Object Browser is helpful is
because you can start at a very general level (Application) and work down through the object
model to the object, property, method, or event for which you are looking. We can literally browse
through the available objects and APIs using the Object Browser.Other ways to find/get help?
Take a Bentley-approved VBA training class or attend the annual Bentley Developer
Conference.REVIEWFinding help is not always easy. Knowing where to look is the first step.
Next, using correct terminology moves us along the path to finding the answers to our questions.
Learning to use tools, such as the Object Browser, provides more answers.Keep in mind that the
most simple subjects still require effort to learn and retain. VBA is no different. If you allow
yourself to become frustrated, the chances of success are diminished. You can learn
MicroStation VBA. You really can.5 Modules, Forms, and Class ModulesWe have already
discussed the basics of how MicroStation VBA projects, modules, forms, and classes are used
to create programs that improve productivity and accuracy That much we know Its time to learn
when to use each of these design elements and how they work together.In this Chapter:
Modules Forms Classes Procedures and FunctionsMODULESCode modules are the foundation
of every VBA project. We use them to declare variables that can be used from within the code
module, by other code modules, by forms, and even by class modules. Windows API functions
are declared in modules so the API calls can be used in our project (more on Windows API
functions later in the book). Procedures and functions inside modules can be run from the VBA
Project Manager. In fact, code modules are so essential that an initial code module is created
every time a new VBA project is created. Procedures written in code modules are the starting
point for running code and displaying forms.Enough talking. Let’s write some code.Let’s begin by
creating a new VBA project named Chapter 05. Save it in the folder C:\MicroStation VBA. After
this new project is created, you can see that a code module named “Module 1” is created
automatically. Rename this module modCh05.Continue by creating a new procedure named
Main. Inside the code module, typeSub Main()When you press the ‹Enter› key after typing the
above code, VBA finishes the new procedure by entering an “Exit Sub” for us. At this point, the
module should look like this:The next thing we are going to do is enter some code in our new
procedure “Main.”Sub Main() 'Declare Variables Dim MyLine As LineElement Dim MyCir As
EllipseElement Dim CenPt As Point3d Dim LineSt As Point3d Dim LineEn As Point3d Dim
RotMatrix As Matrix3d 'Create Horizontal Line LineSt.X = -1 LineEn.X = 1 Set MyLine =
Application.CreateLineElement2(Nothing, LineSt, LineEn)
Application.ActiveModelReference.AddElement MyLine 'Create Vertical Line LineSt.X = 0:
LineSt.Y = 1 LineEn.X = 0: LineEn.Y = -1 Set MyLine =
Application.CreateLineElement2(Nothing, LineSt, LineEn)
Application.ActiveModelReference.AddElement My Line 'Create Circles Set MyCir =
Application.CreateEllipseElement2(Nothing, _ CenPt, 0.25, 0.25, RotMatrix)
Application.ActiveModelReference.AddElement MyCir Set MyCir =
Application.CreateEllipseElement2(Nothing, _ CenPt, 0.5, 0.5, RotMatrix)



Application.ActiveModelReference.AddElement MyCirEnd SubThe code above may look like a
whole lot of gibberish at this point, but it will make much more sense as we continue to learn
VBA together.Notice the comments inserted into the code. Remember, comments begin with an
apostrophe (‘).Running this code draws two circles and two lines in MicroStation that create a
target shape that looks like this:The code works great. From now on, any time we need to draw a
target with these dimensions centered at (0, 0, 0) we have the code to do it. In mere
milliseconds, we can draw this target by running the macro Mainwhenever we wish.The more
hard-coding we do, the less often we will be able to run our macros.If we need to draw the target
centered at (4, 5, 0) we can copy and paste the code, and rename the procedure to Main2. And
then we can create Main3 with different coordinates, then Main4, then Main5 and so on. Right?
Well, we could do that but there is a better way.Lets change the way we are doing things a little
bit. Instead of having Main draw a target at (0, 0, 0), we create a new procedure that draws the
target at the X, Y, and Z coordinates we specify. We will do this by creating parameters for the
new procedure.Sub DrawTarget(CenX As Double, CenY As Double, CenZ As Double) 'Declare
Variables Dim MyLine As LineElement Dim MyCir As EllipseElement Dim CenPt As Point3d
Dim LineSt As Point3d Dim LineEn As Point3d Dim RotMatrix As Matrix3d 'Create Horizontal
Line LineSt.X = CenX - 1 LineSt.Y = CenY LineSt.Z = CenZ LineEn.X = CenX + 1 LineEn.Y =
CenY LineEn.Z = CenZ Set MyLine = Application.CreateLineElement2(Nothing, LineSt,
LineEn) Application.ActiveModelReference.AddElement MyLine 'Create Vertical Line LineSt.X
= CenX LineSt.Y = CenY + 1 LineSt.Z = CenZ LineEn.X = CenX LineEn.Y = CenY - 1
LineEn.Z = CenZ Set MyLine = Application.CreateLineElement2(Nothing, LineSt, LineEn)
Application.ActiveModelReference.AddElement My Line 'Create Circles CenPt.X = CenX
CenPt.Y = CenY CenPt.Z = CenZ Set MyCir = Application.CreateEllipseElement2(Nothing,
CenPt,_ 0.25, 0.25, RotMatrix) Application.ActiveModelReference.AddElement MyCir Set
MyCir = Application.CreateEllipseElement2(Nothing, CenPt,_ 0.5, 0.5, RotMatrix)
Application.ActiveModelReference.AddElement MyCirEnd SubThe code from Main has been
copied and pasted into the same code module. The new pasted procedure is then renamed
DrawTarget. The goal here is to make our code more flexible, so we can draw targets anywhere
we specify. Our new procedure, DrawTarget requires us to specify three parameters named
‘CenX’, ‘CenY’, and ‘CenZ’. We declare them as doubles (very precise numbers). Let’s take a
look at how we use it.Sub Main() 'Draw Targets DrawTarget 0, 0, 0 DrawTarget 3, 0, 0
DrawTarget -3, 0, 0 DrawTarget 0, 3, 0 DrawTarget 0, -3, 0End SubOur procedure Main now
draws five targets. More flexible? More powerful? Absolutely. But the coordinates are still hard-
coded. This may work at times when we are setting up a page that is to be printed in
MicroStation. But how can we let the user specify the coordinates? Let’s expand our program a
little by introducing a graphical user interface.FORMSUser forms provide a graphical user
interface (GUI) for our users. We begin by inserting a new User Form.This form has three abels,
three text boxes and a command button. We will keep the default names for each of these form
elements except for the text boxes. We want to rename the text boxes to txtX, txtY, and txtZ. This



is done in the properties window inside VBA.When a control is selected, we can make changes
to the control’s properties in the properties window. As with other windows in VBA, if the
properties window is not displayed, show it by going to the menu in VBA, View › Properties
Window. After changing the names of the text boxes, change the caption properties of the labels
and the command button to reflect the image shown above. After you modify the properties of
the controls on the form, change the name of the user form to “frmCh05”.We are going to enter
some coordinates in the text boxes. When the user clicks the “Place Target” button, we want to
use the entered coordinates and use the DrawTarget procedure we just created. We need to
write some code in the Click Event of the CommandButton. Double-click on the button when we
are designing in our project to be taken into the Click Event of the CommandButton.We can also
get here by right-clicking on the button and selecting View Code in the pop-up menu.You only
need to enter one line of code to use both the DrawTarget procedure and the values entered into
the form’s text boxes.We are almost finished with this little project. We have a procedure that
draws targets. We have a form that allows users to enter coordinates. We now need to give the
user a way to display the form. We don’t want the user to enter the VBA environment to run this
program, so we will make another change to the procedure named Main.Sub Main() 'Display
the Form frmCh05.showEnd SubSave your VBA program now. It would be a shame to lose this
work. Click on the Save button in VBA.Saved? Good. Now run your program and see how well it
works. From within MicroStation, hold down the ‹ALT› key and press the ‹F8› key on the
keyboard.The macro named Main that is shown is the procedure Main. When it is selected, click
the Run button.The form is displayed so we can enter numbers for X, Y, and Z coordinates to
place our targets.Before we continue, let’s review what we have done.We wanted to allow our
users to draw a target symbol inside MicroStation. The first thing we needed to do was write
some code to draw the target correctly. So we put our code in a procedure named Main and got
the basic code that draws a target shape working by hard-coding everything. When that code
was working properly, we made the code more flexible and useful by taking the code out of Main
and creating a new procedure named DrawTarget. We provided three parameters that could be
used to specify the location of the target. After all of this work was completed, we tested it by
modifying the code in Main to use the Procedure named DrawTarget.The next step was creating
a user interface (more on using forms in Chapter 10). We used the values from the text boxes for
the parameters of DrawTarget (converting the values from a string to a double by using the
standard VBA CDbl function). The last step was to change the code in Main to display the
form.We now have a code module and a form working together using Main to display the form.
When the user clicks the button, values from the form are parameters in DrawTarget, which
resides in the code module. So, why is DrawTarget in the code module? Couldn’t it be in the
code area of the form? Yes, it could be and the code would still work. However, other modules
and other forms would not be able to use DrawTarget as easily if it had been placed in the forms
code area. One of the things that makes a code module so great is that declared procedures
and functions can be easily utilized in other areas of our project. We may have three forms that



are using code in a code module as well as procedures and functions in a different code
module, for example.Our code is working pretty well right now but can we do anything else to
make our project more flexible and powerful? That is a good question.CLASSESYou may know
that we use classes to create objects, but did you know that by putting a little thought into
creating class modules, they can be useful for years to come. How so?In our current project, we
can draw a target at any coordinate we specify. That’s pretty powerful and it meets our needs
today. What happens, however, if a year from now we find we want to change the target’s size?
The procedure DrawTarget only allows entry of three parameters (X, Y, and Z). We could modify
the procedure to require four parameters, the last one specifying the size. But this could break
parts of our code that are only providing three parameters. We could also make the new
parameter optional, but there is a better way.We can create a new class that has X, Y, and Z
properties. It will also have a Draw method. When this is in place, we will add a Scale property.
We could add a Level property, a Color property, a NumberOfCircles property, etc. We can add
these properties today, tomorrow, or next year. It doesn’t matter when we add them. We just
need to make sure that when we add them we do so in a way that allows the previous code
using the class to continue to work properly without modification.Time to write some code.Let’s
add a new class module to our project. Do this by using the VBA menu Insert › Class Module.
Name it cIsTarget (using the Properties Window for this). It will have three properties and one
method. The most basic way to implement properties for classes is to declare variables as
Public in the General Declarations area of the class module. Implement methods by creating
procedures in the class module.Begin by defining the properties.Public X As DoublePublic Y As
DoublePublic Z As DoubleNext implement the Draw method. Recall that you can get this
finished project on the CD that accompanies this book and open it instead of typing in all of the
code. The Draw method was created by copying and pasting DrawTarget and changing ‘CenX’
to ‘X’, ‘CenY’ to ‘Y’, and ‘CenZ’ to ‘Z’ to use the X, Y, and Z properties defined in the class
module.To make sure we are all on the same page, look at the screen shot of the finished
class.And here is the code as it should be typed:Public X As DoublePublic Y As DoublePublic Z
As DoubleSub Draw(X As Double, Y As Double, Z As Double) 'Declare Variables Dim MyLine
As LineElement Dim MyCir As EllipseElement Dim CenPt As Point3d Dim LineSt As Point3d
Dim LineEn As Point3d Dim RotMatrix As Matrix3d 'Create Horizontal Line LineSt.X = X - 1
LineSt.Y = Y LineSt.Z = Z LineEn.X = X + 1 LineEn.Y = Y LineEn.Z = Z Set MyLine =
Application.CreateLineElement2(Nothing, LineSt, LineEn)
Application.ActiveModelReference.AddElement MyLine 'Create Vertical Line LineSt.X = X
LineSt.Y = Y + 1 LineSt.Z = Z LineEn.X = X LineEn.Y = Y - 1 LineEn.Z = Z Set MyLine =
Application.CreateLineElement2(Nothing, LineSt, LineEn)
Application.ActiveModelReference.AddElement My Line 'Create Circles CenPt.X = X CenPt.Y
= Y CenPt.Z = Z Set MyCir = Application.CreateEllipseElement2(Nothing, CenPt, _ 0.25,
0.25, RotMatrix) Application.ActiveModelReference.AddElement MyCir Set MyCir =
Application.CreateEllipseElement2(Nothing, CenPt, _ 0.5, 0.5, RotMatrix)



Application.ActiveModelReference.AddElement MyCirEnd SubOnce everything is in place, we
can use it as follows:Instead of using the DrawTarget procedure we previously created, we can
use the cIsTarget class. Comment out the ‘DrawTarget’ line of code. Next declare a variable as a
“New clsTarget” then set the X, Y, and Z properties of the object and invoke the Draw
method.Class modules are often considered reserved for advanced programmers but this
doesn’t need to be the case. As we see here, classes can be implemented very easily and
simply. We will discuss classes in greater detail in a later chapter.PROCEDURES AND
FUNCTIONSModules, forms, and classes each use procedures and functions. Procedures are
declared with the “Sub” keyword and functions are declared with the “Function” keyword.Let’s
look at a few procedures and functions.Sub DrawCircle() 'Declare Variables Dim MyCir As
EllipseElement Dim CenPt As Point3d Dim RotMatrix As Matrix3d 'Create Circle CenPt.X = 0
CenPt.Y = 0 CenPt.Z = 0 Set MyCir = Application.CreateEllipseElement2(Nothing, CenPt, _
0.25, 0.25, RotMatrix) Application.ActiveModelReference.AddElement MyCirEnd
SubDrawCircle draws a circle at (0, 0, 0) with a radius of 0.25. It can be run by itself without the
any other procedure or function.Sub DrawCircle2(Radius As Double) 'Declare Variables Dim
MyCir As EllipseElement Dim CenPt As Point3d Dim RotMatrix As Matrix3d 'Create Circle
CenPt.X = 0 CenPt.Y = 0 CenPt.Z = 0 Set MyCir =
Application.CreateEllipseElement2(Nothing, CenPt, _ Radius, Radius, RotMatrix)
Application.ActiveModelReference.AddElement MyCirEnd SubDrawCircle2 is a procedure with
a single required parameter. DrawCircle2 cannot be run by itself — it requires another procedure
or function to run it. When it is called by another function or procedure, the required parameter
“Radius” must be supplied like this:DrawCircle2 1.5Sub DrawCircle3(X As Double, Y As Double,
Z As Double, _ Optional Radius As Double = 1.25) 'Declare Variables Dim MyCir As
EllipseElement Dim CenPt As Point3d Dim RotMatrix As Matrix3d 'Create Circle CenPt.X = X
CenPt.Y = Y CenPt.Z = Z Set MyCir = Application.CreateEllipseElement2(Nothing, CenPt, _
Radius, Radius, RotMatrix) Application.ActiveModelReference.AddElement MyCirEnd
SubDrawCircle3 requires us to provide X, Y, and Z values and gives the option of providing a
radius. If we supply a radius, it uses the value we give it. If we do not provide the radius, it used a
value of 1.25.Here is one way to test our procedure DrawCircle3:Sub TestDrawCircle3()
DrawCircle3 2.25, 2.25, 0 DrawCircle3 2.25, 2.25, 0, 1.125End SubThe first time we call
DrawCircle3 we do not provide the optional parameter. The second time we call it we provide a
radius value of 1.125. The first circle will be drawn with a radius of 1.25 (the default value) and
the second will be drawn with a radius of 1.125.Once an Optional Parameter is declared in the
Procedure, any parameters after it must also be optional.As we call functions and procedures,
VBA displays a tip that shows us the parameters for the function or procedure that we are calling.
Notice how the radius parameter is enclosed in square brackets. The square brackets tell us that
“Radius” is an optional parameter. We are also shown the value of the optional parameter that
will be used if we do not supply a value.Another type of parameter that can be declared in a
procedure or function is called ParamArray. A ParamArray must be the last parameter declared,



because when we supply a value or values to the parameter in code, we can supply any number
of values for the parameter. Here is an example of how it is declared and used in code:Sub
DrawCircle4(X As Double, Y As Double, Z As Double, _ ParamArray Radii() As Variant)
'Declare Variables Dim MyCir As EllipseElement Dim CenPt As Point3d Dim RotMatrix As
Matrix3d Dim I As Long 'Create Circles CenPt.X = X CenPt.Y = Y CenPt.Z = Z For I =
LBound(Radii) To UBound(Radii) Set MyCir = Application.CreateEllipseElement2(Nothing,
CenPt, _ Radii(I), Radii(I), RotMatrix) Application.ActiveModelReference.AddElement
MyCir Next IEnd SubWe dont know how many radius values will be provided in the Radii
ParamArray. So, we use a For ... Next loop which allows us to look at each one and use it in
creating a new circle. Here is an example of how we call a procedure with a ParamArray in
code:Sub TestDrawCircle4() DrawCircle4 1, 1, 0, 0.25, 0.5, 0.75, 1, 1.25, 1.5End SubWe
provide an X of 1, a Y of 1, and a Z of 0. Then we begin providing radius values. After the code is
run, we have six new circles in our MicroStation design file.Here are the six circles created by
TestDrawCircle4.We have created over 100 lines of code so far in this chapter. The current
module now has nine different procedures in it. Five of them can be run by themselves, the
others must be called by other procedures or functions.Speaking of functions, let’s examine
them in detail.Function Pi() As Double Pi = Atn(l) * 4End FunctionHere is a function named Pi. It
does not accept any parameters and the type of value it returns is a Double.We specify what
value is to be returned by assigning the return value to the name of the function.This function, Pi,
can be used now wherever we need the value of Pi. The procedure DrawCircle3 allows us to
provide the radius of the circle to be drawn. But what do we do if we only know the area of the
circle we want drawn? We can calculate the radius if we know the area but we need the value of
Pi to do so. Rather than hard-coding a value of “3.14159” for Pi, we can use the Pi function we
just created.Sub TestPi() Dim CircleArea As Double Dim CircleRadius As Double CircleArea =
3.5 CircleRadius = Sqr(CircleArea / Pi) DrawCircle3 2.5, 2.5, 0, CircleRadiusEnd SubWe
calculate the radius of the circle based on a given area. We then use that value in the radius
parameter of the procedure DrawCircle3.The function Pi we just created does not have any
parameters. It does not need them because the calculation is always the same. Let’s look at a
few additional functions that come in handy from time to time. They are named RTD (Radians To
Degrees) and DTR (Degrees To Radians).Function RTD(AngleinRadians As Double) As Double
RTD = AngleInRadians * 180 / PiEnd FunctionFunction DTR(AngleInDegrees As Double) As
Double DTR = AngleInDegrees * Pi / 180End FunctionThese two functions perform calculations
that are very common to those of us who use MicroStation. They are shown here for instructional
purposes only because MicroStation’s VBA implementation has a function named Degrees that
converts radians to degrees and a function named Radians that converts degrees to
radians.The functions DTR and RTD (as well as the functions Degrees and Radians) have one
required parameter. Here is how we use them:Sub DrawArcl() Dim MyArc As ArcElement Dim
CenPt As Point3d Dim RotMatrix As Matrix3d Set MyArc =
Application.CreateArcElement2(Nothing, CenPt, 1.5, _ 1.5, RotMatrix, DTR(45), DTR(90))



Application.ActiveModelReference.AddElement MyArcEnd SubCreateArcElement2 requires
several parameters. One of them is the Start Angle. Another is the Sweep Angle. Both
parameters require the value to be given in radians. Many of us don’t normally think in radians,
we think in degrees. So, we can use the DTR function shown above to convert from degrees
(which we think in) to radians (which the function is expecting).Here is the arc created by the
above code. It begins at 45 degrees and has a sweep of 90 degrees.Returning an
ArrayFunctions return a value, right? Yes. But functions can actually return more than one value
through the use of an array.The underscore (_) character allows one line of code to span
multiple lines.As we will discuss more in the next chapter, but for now know that an array is a
variable that contains more than one value and that we can return an array in a function. Here’s
what it looks like:Function PolarPoint(X As Double, Y As Double, Z As Double, Angle As
Double, Distance As Double) As Variant Dim XChange As Double Dim YChange As Double
XChange = Cos(Angle) * Distance YChange = Sin(Angle) * Distance Dim PPoint(0 To 2) As
Double PPoint(0) = X + XChange PPoint(1) = Y + YChange PPoint(2) = Z PolarPoint =
PPointEnd FunctionThe PolarPoint function allows us to define a starting point (X, Y, and Z), an
angle, and a distance. In return, we are given the resulting X, Y, and Z elements of the coordinate
as an array.We return an array by declaring the return type of the function as a variant. As we will
learn in the discussion on variables, a variant can hold any type of value, object, or array of
values or objects. We declare an array of doubles within the function and then we assign the
array variable to the function name. Here’s one way to test the PolarPoint function.Sub
TestPolarPoint() Dim StartCen As Point3d Dim CenPt As Point3d Dim RotMatrix As Matrix3d
Dim X As Variant StartCen.X = 2 StartCen.Y = 2 StartCen.Z = 0 Set MyCir =
Application.CreateEllipseElement2(Nothing, _ StartCen, 1, 1, RotMatrix)
Application.ActiveModelReference.AddElement MyCir Dim RotAngle As Double For RotAngle
= 0 To 360 Step 30 X = PolarPoint(StartCen.X, StartCen.Y, StartCen.Z, _ DTR(RotAngle),
4) CenPt.X = X(0) CenPt.Y = X(l) CenPt.Z = X(2) Set MyCir =
Application.CreateEllipseElement2(Nothing, _ CenPt, 1, 1, RotMatrix)
Application.ActiveModelReference.AddElement MyCir Next RotAngleEnd SubWhat do we get
when we run TestPolarPoint?Returning ‘Types’Thus far we have written functions that return
either a single value or an array of values. You can also return types. MicroStation VBA has a
‘Point3d’ type with three properties: X, Y, and Z. Let’s copy and paste the PolarPoint function and
make use of this type.Function PolarPoint2( X As Double, Y As Double, Z As Double, _ Angle
As Double, Distance As Double) As Point3d Dim XChange As Double Dim YChange As
Double XChange = Cos(Angle) * Distance YChange = Sin(Angle) * Distance Dim PPoint(0 To
2) As Double PolarPoint2.X = X + XChange PolarPoint2.Y = Y + YChange PolarPoint2.Z =
ZEnd FunctionInstead of returning an array as in the previous example, we are returning a
Point3d type. Here is an example that uses the PolarPoint2 function:Sub TestPolarPoint2() Dim
StartCen As Point3d Dim CenPt As Point3d Dim RotMatrix As Matrix3d Dim X As Variant
StartCen.X = 2 StartCen.Y = 2 StartCen.Z = 0 Set MyCir =



Application.CreateEllipseElement2(Nothing, _ StartCen, 1, 1, RotMatrix)
Application.ActiveModelReference.AddElement MyCir Dim RotAngle As Double For RotAngle
= 0 To 360 Step 30 CenPt = PolarPoint2(StartCen.X, StartCen.Y, StartCen.Z, _
DTR(RotAngle), 4) Set MyCir = Application.CreateEllipseElement2(Nothing, _ CenPt, 1,
1, RotMatrix) Application.ActiveModelReference.AddElement MyCir Next RotAngleEnd
SubReturning ObjectsOne additional return type is worth mentioning. In addition to returning
values and types, a function can return objects. Here is one example.Function GetExcelWS() As
Object Dim ExcelApp As Object Set ExcelApp = GetObject(, "Excel.Application") Set
GetExcelWS = ExcelApp.activesheetEnd FunctionThis function gets the active worksheet in
Microsoft Excel. Excel must be running for this function to work correctly. How do we use it? Let’s
take a look.Sub TestGetExcelWS() Dim MyWS As Object Dim Cell1 As Double Dim Cell2 As
Double Dim Cell3 As Double Set MyWS = GetExcelWS Cell1 = MyWS.Range("B2") Cell2 =
MyWS.Range("C2") Cell3 = MyWS.Range("D2")End SubThis procedure gets the values of
three cells in Excel. It really is very easy to get data from or write data to Excel. We will discuss
more on working with Microsoft Excel later in this book.ByVal and ByRefWe have seen how we
can provide parameters when we call procedures and functions. By default, values are passed
by reference. The other way values can be passed is by value. What do these mean?Sub
GetThreeVals(X As Double, Y As Double, Z As Double) X = 1 Y = 2 Z = 3End SubThis
procedure accepts three parameters. Inside the code, we use the parameters names and assign
values to them. It is important to understand this is because using variables directly in this
manner will change the values in the function or procedure that calls this procedure.Sub
TestGetThreeVals() Dim A As Double Dim B As Double Dim C As Double A = 100 B = 200 C
= 300 GetThreeVals A, B, CEnd SubHere we have variables A, B, and C. We assign values of
100, 200, and 300 respectively. Then we use these variables (A, B, and C) when we call
GetThreeVals. Since the procedure GetThreeVals has its parameters declared without the
keyword “ByVal”, the values are passed into the procedure “ByRef”. ByRef means the values of
the parameters may be modified inside the procedure. And if they are modified in the procedure,
the variables will maintain these values outside of the procedure. So, before the line of code
“GetThreeVals A, B, C” is executed, the values of A, B, and C are 100, 200, and 300. After
GetThreeVals is executed, the values of A, B, and C are 1, 2, and 3.GetThreeVals changes the
values of the parameters that are passed in. This can be a powerful feature if it is used correctly.
It can also cause a great deal of confusion if it is not understood. Suddenly, variables that were
holding one value could hold another value.If we do not want a function or procedure to change
the values of the variables passed as parameters, there are a couple of ways we can do this.
The first technique requires discipline on our part. The second technique is a more definite
method.Sub GetThreeVals2(X As Double, Y As Double, Z As Double) Dim dblX As Double Dim
dblY As Double Dim dblZ As Double dblX = X dblY = Y dblZ = Z dblX = 1 dblY = 2 dblZ =
3End SubInstead of manipulating the parameters directly, we place the values of the parameters
into variables declared inside the procedure. Then we manipulate these local variables. This



keeps us from changing the parameters.Another way to maintain the integrity of the parameters
passed into our functions and procedures is to declare them explicitly as “ByVal”.Sub
GetThreeVals3(ByVal X As Double, ByVal Y As Double, _ ByVal Z As Double) X = 1 Y = 2 Z
= 3End SubTaking the additional step of declaring a parameter as ByVal guarantees the integrity
of the parameters.Declaring VariablesVariables are used extensively throughout our code.
Variables are declared with a name and a type. We will learn more about this in the next chapter.
What is important to understand now is that variables have a scope. There is a pre-determined
amount of time when a variable can be used. The variables scope depends on where it is
declared and what keywords (if any) are used when it is declared. There are two places where
variables can be declared. One place is inside the procedures and functions in which they will be
used. We have seen numerous examples of this so far. The other place we declare variables is in
the General Declarations area of code modules, forms, and class modules.In the General
Declarations area of this code module, I declared three variables as the same type (as doubles)
but used different keywords to declare them: Dim, Private, and Public.Dim StartPointX as
DoubleDeclaring a variable with “Dim” in the General Declarations area of a code module or
form code area means the variable is only available for use from within that module, form, or
class module. StartPointX was declared by using the “Dim” keyword so, again, it can only be
used from within the module or form in which it is declared.‘Private’ has the same effect as using
‘Dim’. You can use the variable within any function or procedure in the code area in which it is
declared. One function can set its value and another function in the same module, form, or class
can read the value.‘Public’ variable declarations behave differently depending on where the
declarations are made.Forms - Publicly declared variables are in scope when the form is in
scope (usually only when it is displayed). Other areas of a project can access the variable
through the form’s name. For example,UserForm1.TestVariable = 4.5We can use the variable
TestVariable only by addressing it through the form and the form must be ‘in scope’ for this to
work.Modules - Publicly declared variables are in scope for all areas within the same
project.Classes - Publicly declared variables are seen as read/write properties for the
class.Option ExplicitBy default, if we attempt to use a variable that is not declared, it inherits the
type of ‘Variant’. We can force ourselves to declare variables by using “Option Explicit” in the
General Declarations area of modules, forms, and classes.In this example, we have declared
“Option Explicit” in the General Declarations area. When we attempt to run the macro test shown
above we get an error.To avoid this error, we need to declare X as a double, integer, or long.
More on variable types in the next chapter.REVIEW Write code as procedures, functions, or
inside user form events. In procedures and functions utilize required and optional parameters. In
functions you can return values, arrays, types, and objects. In procedures and functions you can
make changes to the variables passed into them as parameters if the parameters are declared
as “ByRef ”. Declare a parameter as “ByVal” to keep the variable’s value from changing. Declare
variables in procedures, functions, and events or in the General Declarations area. The scope of
these variables depends on where they are declared and what keywords accompany the



declaration.6 Variables1 + N + 3 = 7What is N? N is a variable. In the above equation it
represents a number. If we were to solve for N we would get a value of 3.“Learning MicroStation
VBA “ & N & “ Easy.”What is N? N is a variable. In the above equation it represents a string of
characters.What string of characters does it represent? “IS”.In this Chapter: Standard VBA
Variable Types MicroStation-Specific Variable Types Assigning Values and Setting Objects
Arrays Constants Variable Names Option Explicit Using VariablesSTANDARD VBA VARIABLE
TYPESA variable is a name that represents a value or an object. The examples above show
variables with a name of N. In one instance the variable holds a numeric value. In the other it
holds a string of characters. In general, we know in advance what type of value or object a
variable will be representing. Since we know this, we specify what type of variable we will use by
declaring it.Dim N as Integer N = 7 - 3 - 1Here, we declare the variable N as an integer. This
means it will be a whole number between -32,768 and 32,767.Dim N As String N = "IS"
MsgBox "Learning MicroStation VBA " & N & " Easy."Here we declare N as a string. A string is a
group of characters. After a variable is assigned a value, you can use it in the place of a number,
text, or some other type of value or object.We will use variables extensively throughout this book.
Let’s examine some of the more common types of variables available to us.IntegerDim
PageNumber as Integer PageNumber = 2We said that an integer is a whole number between
-32,768 and 32,767. If we need a variable to hold a value greater than or less than the range of
an integer, we must declare it as something different.LongDim MySalary as Long MySalaray =
123456A long is a whole number between -2,147,483,648 and 2,147,483,647. These numbers
are much larger than those in the range of an integer. It requires more memory to allow for this
greater range of numbers so we should only use it when we need it.DoubleDim
HoursToLearnVBA as Double HoursToLearnVBA = 36.25A double is also called a double
precision floating point number. What does that mean? It means the precision available for a
double is twice the precision available for single (also a variable type but not used as much) and
the decimal point can float to allow for greater precision of small numbers or larger numbers with
less precision. It is important to understand the “floating point” portion of the description. If we
expect an extremely large number to be extremely accurate, we may not only be disappointed
but we could have less accurate results than we expected.Consider this next macro,
VariableTestC. It has a variable named N declared as a double in which the numbers
“1234567890123456789” have the decimal in a different position each time with the last two
numbers shown are ‘46’. VBA rounds the ‘456’ number to ‘46’ because a double variable is given
a specific amount of memory in which to keep its value. When we attempt to put more in it than it
can handle, it rounds the number to something it can hold. Sub VariableTestC() Dim N As
Double N = 1.23456789012346 N = 12.3456789012346 N = 123.456789012346 N =
1234.56789012346 N = 12345.6789012346 N = 123456.789012346 N =
1234567.89012346 N = 12345678.9012346 N = 123456789.012346 N =
1234567890.12346 N = 12345678901.2346 N = 123456789012.346 N =
1234567890123.46 N = 12345678901234.6 End SubDoubles can hold very precise numbers



but as the value of the number increases, the precision decreases. This is something to keep in
the back of your mind as you develop applications.BooleanDim ICanLeannThis as Boolean
ICanLeannThis = TrueA Boolean data type can hold one of two values: True or False.DateDim
XMReleaseDate as Date XMReleaseDate = "5/19/2006 8:00:00 AM"A Date data type holds a
Date/Time value.StringDim MyLevelName as String MyLevelName = "utilElectnicity"A string
data type contains text. Letters, numbers, and other characters we on our computer keyboards
can be held inside this variable. We have seen that numeric variable types have ranges of
values. This is because their data types have a predefined amount of memory set aside for each
variable. Strings are no different. So how many characters can be held inside a string variable?
Approximately 2 billion (2,000,000,000). That is a lot of characters.ObjectDim MyExcelApp as
Object Set MyExcelApp = GetObject(, "Excel.Application")Object type variables point to
objects. The variable MyExcelApp, for example, could point to an instance of Microsoft Excel, an
application. Microsoft Excel is an object with specific properties, methods, and events. Others
objects have their own unique properties, methods, and events. When we declare a variable as
an object, it is a generic object without any previous knowledge of its properties, methods, or
events. Only after we set the variable to an object does it know what kind of an object it is as well
as its other attributes.VariantDim PointArray as VariantVariables declared as a variant can hold
any type of value, point to any type of object, or even contain an array of
values.MICROSTATION-SPECIFIC VARIABLE TYPESThe variable types we have discussed
are standard VBA variable types. They can be used in MicroStation VBA, in Excel VBA, in Word
VBA, or in Access VBA. Let’s consider some of the variable types specific to MicroStation that
we will regularly use.ApplicationDim MSApp As Application Set MSApp = ApplicationThe
application variable type points to the MicroStation application. It is the top level object when
dealing with MicroStation. A few of the things we can do from a variable declared and set to the
MicroStation application are: Get the ActiveDesignFile property Get the ActiveModelReference
property Get the ActiveSettings object and its properties Get the ExecutingVBProject object and
its properties Get the UserName property Get the left, top, width, and height
propertiesDesignFileDim MyDGN As DesignFile Set MyDGN =
Application.ActiveDesignFileThe DesignFile object refers to a MicroStation DGN file. Top-level
DGN properties and collections are available to us via the DesignFile object. Get and set the
Author, Client, Comments, Company, Keywords, Manager, Subject, and Title Properties Get the
Form atMajor Version and Form atMinor Version properties Get the Levels collection Get the
Models collection Get the Name and Path propertiesModelReferenceDim MyModel As
ModelReference Set MyModel = Application.ActiveModelReferenceThe ModelReference
object is where the rubber meets the road. When we draw inside a file, we do it through the
ModelReference object. When we want to find out what is in a file, we do it through the
ModelReference object. We will work extensively with this object throughout this book.LevelDim
MyLevel As Level Set MyLevel = Application.ActiveDesignFile.Levels(1)Levels allow us to
divide our designs into groups of objects. We usually group our objects based on their specific



type of geometry or annotation. Road centerlines may be placed on one level, Lot numbers on
another, and title block lines on another, etc. Here are a few of the properties we can get and set
from the level object: Description ElementColor Element1ineStyle Element1ineWeight IsActive
IsDisplayed IsFrozen IsLocked Name Number PlotLineElementDim MyLine As LineElement Set
MyLine = Application.CreateLineElement2(Nothing, _ Point3dFromXYZ(0, 0, 0),
Point3dFromXYZ(4, 5, 6)) Application.ActiveModelReference.AddElement My LineA
LineElement is created with a start point and an end point. After it is created, we can add it to our
model.EllipseElementDim MyCircle As EllipseElement Dim RotMatrix As Matrix3d Set
MyCircle = CreateEllipseElement2(Nothing, _ Point3dFromXYZ(0, 0, 0), 1.5, 1.5, RotMatrix)
Application.ActiveModelReference.AddElement MyCircleLines, circles, and arcs form the basis
of much of the geometry found in our MicroStation files. From MicroStation’s perspective, circles
are essentially ellipses with equal major and minor radii. The code shown above draws a circle
centered at (0, 0, 0) with a radius of 1.5.ArcElementDim MyArc As ArcElement Dim RotMatrix
As Matrix3d Set MyArc = CreateArcElement2(Nothing, _ Point3dFromXYZ(0, 0, 0), 1.75,
1.75, _ RotMatrix, Radians(45), Radians(90))
Application.ActiveModelReference.AddElement MyArcWe are given several ways to create a
new LineElement, EllipseElement, and ArcElement. In this example, we create a new
ArcElement by providing a center point, major and minor radii, a start angle, and a sweep
angle.TextElementDim MyText As TextElement Dim RotMatrix As Matrix3d Set MyText =
CreateTextElement1(Nothing, "MicroStation VBA", _ Point3dFromXYZ(0, 0, 0),
RotMatrix) Application.ActiveModelReference.AddElement MyTextThe TextElement object
needs the text to display and a starting point. When it is created we can set other properties
such as the color, level, and textstyle (which includes font, size, etc.).We use many more types
of objects when programming MicroStation in VBA and there is much more to learn about the
objects we have just introduced. They will be covered in greater detail as we continue to learn
MicroStation VBA.ASSIGNING VALUES AND SETTING OBJECTSValue-type variables and
object-type variables are declared similarly. When giving the variables values or setting them to
objects, there is one major difference.Dim Level Name As String Level Name = "Easement"
Dim Easement Level As Level Set EasementLevel = _
ActiveDesignFile.AddNewLevel(LevelName)Here we have two variables. One is declared as a
string and the other as a Level.We assign a value to the Level Name variable by stating the
variable by name, using an equal sign, and then the value we want it to have. When we use the
Level object, we use the keyword ‘Set’ to set the variable to an object. We only use ‘Set’ when
we are setting a variable to an object. After it is set to an object we can address it by its name
without using Set.ARRAYSWhen we think about an array in MicroStation, we think about taking
an element and copying it multiple times. An array in VBA is a single variable name with multiple
elements in it.Dim StartPoint(0 to 2) as Double StartPoint(0) = 4.5 StartPoint(l) = 5.6
StartPoint(2) = 6.7In this example, we declared a variable as an array with three elements
numbered 0, 1, and 2. We can address the elements individually by specifying their index within



the array.In the next example, I created an array where each Point3D type has an X property, a Y
property, and a Z property. Notice how I addressed each element in the array by its index (0 and
1) and then addressed the X, Y, and Z properties. Sub ArrayTestA() Dim MyVerticies(0 To 1)
As Point3d Dim MyLine As LineElement MyVerticies(0).X = 1 MyVerticies(0).Y = 2
MyVerticies(0).Z = 3 MyVerticies(1).X = 4 MyVerticies(1).Y = 5 MyVerticies(1).Z = 6
Set MyLine = CreateLineElement1(Nothing, MyVerticies) ActiveModelReference.AddElement
MyLine End SubCONSTANTSA constant is similar to a variable with one significant difference:
a constant value does not change.Const PI As Double = 3.14159You can declare constants as
public in the General Declarations area of a code module, as shown above, from within
individual procedures and functions. Constants are useful any time you need a value that does
not change. For example, if you are writing a program that labels line lengths in a design file, you
could specify a constant for the distance the text is to be offset from the line. A constant can also
provide a units conversion factor, such as from inches to cubits.Another reason to use a
constant is for calculations that make routine references to specific values, such as a ShimWidth
value in multiple calculations. Instead of using a value of 0.6 when we make the calculations, we
can declare a constant with a name of ShimWidth and assign it a constant value of 0.6. This
makes our code easier to read and allows us to change our ShimWidth value in only one place
(where the constant is declared) instead of wherever the value is used.VARIABLE
NAMESThousands of pages of text have been devoted to naming variables. The best place to
start this discussion is with the rules imposed on us by VBA. Variables must begin with an alpha
character (A through Z). Variable names cannot contain spaces. Name characters are A-Z, 0-9,
and _ (underscore). Variable names must be 255 characters or less. Variable names cannot be
keywords (such as ‘Dim’, ‘New’, ‘Left’, ‘Right’, ‘Form’, ‘Public’). Letters used in variable names
can be uppercase or lowercase.Based on the rules already identified, here are a few variable
declarations that work:Dim myLine As LineElement Dim txteMyText As TextElement Dim
strName As String Dim dblStartX As Double Dim intLevelNumber As Integer Dim
pt3dStartPoint As Point3dEach of the declarations shown above are legitimate variable
declarations. They follow the rules. The first, myLine, is slightly different than the others. Each of
the other declared variables begins with characters that identify the type of variable. strName
says the variable type is a string. dblStartX says we are working with a double type variable.It is
important to know if a project requires using variable naming conventions. A naming convention
is an additional set of rules on how to name variables. For example, one convention may state
that each variable name begin with three characters followed by an underscore (_) character,
then a name consisting of no more than seven characters. Another convention may not use an
underscore. Yet another convention may require that the scope of the variable be identified
inside the variables name.As mentioned, many pages have been devoted to the topic of variable
naming conventions, so we will not spend much time here on the subject. You should
understand that naming a variable myLine or lineMyLine or line123 does not cause your
program to work any differently than naming it elemline_LineA.Naming conventions can extend



beyond variable names. Procedure names, function names, and control names can also be
within the scope of a naming convention.Here is a link to a web page that discusses variable
naming conventions:http://msdn.microsoft.com/library/en-us/modcore/html/
deconVariableNames.aspAnother way to become familiar with naming conventions is to search
online for “variable naming convention” or “Hungarian Notation”.Case SensitivityConsider the
following variable declarations:Dim myLine As LineElement Dim MYline As LineElementSince
VBA is not concerned with capitalization in variable names, the two variables declared above
are the same. When we use a variable inside VBA, VBA automatically changes the capitalization
to that used in the declaration. Some programmers use this to make sure they do not introduce
typos into their code. They may always use a capital letter somewhere in the variable name
when they declare it and then type all lower-case when they use it. When a line of code is
complete and the cursor is moved to the next line of code, VBA automatically updates the
capitalization of the variable that had been typed in lowercase.OPTION EXPLICITWe have
spoken for a while about variable types and declaring variables. There are many arguments as
to why we should declare our variables. However, VBA does not force us to do so. It is possible
to use a variable even if it is not formally declared. When we do this, the variable takes on the
characteristics of a specific variable type when it is first used. For example, it will be a ‘Variant
Double’ if its value is 1.23456. Or it will become a ‘Variant String’ if its value is “owhatafooliam”.
One way we can make sure we declare our variables is to use “Option Explicit” in the General
Declarations area of our modules. Another way is to go to the VBA menu Tools ›
Options.Checking the ‘Require Variable Declaration button causes VBA to enter “Option Explicit”
for us.USING VARIABLESAfter a variable is declared and a value is applied to it or it is set to an
object, the variable can be used any time the value is needed.Sub VariableTestD() Dim
MySalary As Double Dim MyHourly As Double MySalary = 1234567 MyHourly =
MySalary / 52 / 40 MsgBox "My Hourly Rate is " & FormatCurrency(MyHourly, _ 2,
vbFalse, vbFalse, vbTrue) End SubHere we have two variables. One of them (MySalary) is given
a value of 1234567. We then use MySalary to calculate MyHourly. We then use the standard
VBA function FormatCurrency to convert the variable MyHourly to a two-decimal place currency
value and concatenate “My Hourly Rate is” with the result of the FormatCurrency
function.REVIEWVariables are names that hold values or refer to objects. Variables declared
within a function, procedure, or event are local to that function and cannot be used outside of it.
Variables declared in the General Declarations area of a form or code module can be used from
within the form or code module in which they are declared. Variables declared as ‘Public’ inside
a code module can be used anywhere in the VBA project. Variables declared as ‘Public’ in class
modules become read/write properties of that class module.We will use variables extensively
throughout this book. After all, without variables everything would be static — nothing could
change. Lines would always be drawn from the same point to the same point and text would
always be inserted at the same point and would always say the same thing.7 Working With
TextWe work with text every day This book is composed of text: words, phrases, sentences,



paragraphs. The ability to work with text is invaluable in our programming.Recall that the type of
variable that deals with text is a String.Sub TextWork01() Dim BookTitle As String BookTitle =
"Learning MicroStation VBA" MsgBox UCase(BookTitle) MsgBox LCase(BookTitle) MsgBox
Left(BookTitle, 12) MsgBox Right(BookTitle, 12)End SubIn this example, we have a variable
named BookTitle that is declared as a String. It is given a value of “Learning MicroStation VBA”.
Four different functions are then used with the variable BookTitle as a parameter and the result
displays in four MessageBoxes.VBA STRING FUNCTIONSLet’s take a look at each of the VBA
functions that deal with text (Strings) one-by-one.UCaseFunction UCase(String)The UCase
function converts the supplied string to upper case.Sub TextWork02() Dim strNewLevel As
String strNewLevel = InputBox("Enter New Level Name:") strNewLevel = UCase(strNewLevel)
Application.ActiveDesign File.AddNewLevelstrNewLevelEnd SubIn this example we use an
InputBox to allow the user to enter the name of a new level. We then convert it to upper case and
use it to add a new level (AddNewLevel) to the active design file.LCaseFunction
LCase(String)The LCase function converts the supplied string to lower case.Sub TextWork03()
Debug.Print LCase("LCase Lowers Capital Letters.")End SubIn this example we used text
directly in the function instead of assigning the text to a variable.Debug.Print is used to place text
in the Immediate Window. It is often used to display text to aid in debugging our applications. To
view the Immediate Window, go to the VBA menu View › Immediate Window.StrConvFunction
StrConv(String, Conversion As VbStrConv, _ [LocaleID As Long])StrConv is used to convert
the provided string through a variety of parameters. The constant most used with StrConv is
VbProperCase’.Sub TextWork04() Dim BookTitle As String BookTitle = "learning microstation
vba" MsgBox StrConv(BookTitle, VbProperCase)End SubThis example uses the vbProperCase
constant to capitalize the first letter of each word.WeekDayName, WeekDayNumberFunction
WeekdayName(Weekday As Long, _ [Abbreviate As Boolean = False], _ [FirstDayOfWeek As
VbDayOfWeek = vbUseSystemDayOfWeek]) _ As StringEach day of the week (Sunday through
Saturday) has a number assigned to it. The Weekday Name function takes that number and
converts it to the day’s name.Sub TextWork05() Dim TodaysDate As Date Dim
WeekDayNumber As Long TodaysDate = Now WeekDayNumber = Weekday(TodaysDate)
MsgBox WeekdayName(WeekDayNumber) MsgBox WeekdayName(WeekDayNumber,
True)End SubThe first parameter supplied to WeekdayName is the day number. The second
parameter, ‘Abbreviate’, is optional with a default of false. When we supply a value of true, the
WeekDayName is abbreviated.MonthNameFunction MonthName(Month As Long, _
[Abbreviate As Boolean = False]) As StringThe MonthName function is similar to the
WeekdayName function but as the name implies, it returns the name of the month instead of the
name of the day.Sub TextWork05B() Dim MonthNum As Long For MonthNum = 1 To 12
Debug.Print MonthName(MonthNum) Next MonthNumEnd SubLTrim, RTrim, TrimFunction
LTrim(String) Function RTrim(String) Function Trim(String)Use the Trim functions to remove
spaces from the beginning, end, and both beginning and end of a string.Sub TextWork06() Dim
StringToTrim As String StringToTrim = " Trim Functions Trim Space Characters. " Debug.Print



LTrim(StringToTrim) Debug.Print RTrim(StringToTrim) Debug.Print Trim(StringToTrim)End
SubStrCompFunction StrComp(String1, String2, _ [Compare As VbCompareMethod =
vbBinaryCompare])The need to compare two pieces of text is common. Is “Sidewalk” the same
as “SIDEWALK”? Not always.Sub TextWork07() Dim strNewLevel As String Dim lvlExistLevel
As Level strNewLevel = InputBox("Enter New Level Name:") For Each lvlExistLevel In
Application.ActiveDesignFile.Levels If StrComp(strNewLevel, lvlExistLevel.Name, _
vbTextCompare) = 0 Then MsgBox "The level " & strNewLevel & " already exists." Exit
Sub End If Next Application.ActiveDesign File.AddNewLevelstrNewLevelEnd SubThis
procedure asks the user for a new level name. It compares the newly-entered name with the
name of each existing level name. If it finds a match, a MessageBox displays and we exit the
procedure.StrComp allows us to specify how the provided text is to be compared. In the above
example, the constant ‘vbTextCompare’ returns a value of zero (0) when the characters are the
same, independent of the capitalization. With ‘vbTextCompare’, “SWalk” and “swalk” are the
same.Sub TextWork08() Debug.Print StrComp("SWalk", "swalk", vbTextCompare)
Debug.Print StrComp("swalk", "SWalk", vbTextCompare) Debug.Print StrComp("SWalk",
"swalk", vbBinaryCompare) Debug.Print StrComp("swalk", "SWalk", vbBinaryCompare)End
SubStrComp lets us know whether the provided text is the same but it also tells us which text
comes before the other. It is often used for sorting text alphabetically.Here is one more example
of StrComp, called a bubble sort. It takes an array of strings and sorts them alphabetically. This
technique is a little more advanced, so it may be good to return to it after we have learned more
VBA programming.Sub BubbleSort() Dim strNms(0 To 7) As String strNms(0) = "Jerry"
strNms(l) = "Candice" strNms(2) = "Brandon" strNms(3) = "Kyle" strNms(4) = "Benjamin"
strNms(5) = "Jacob" strNms(6) = "Nathan" strNms(7) = "Olivia" Dim MadeChange As Boolean
Dim tmpName As String Dim I As Long MadeChange = True While MadeChange = True
MadeChange = False For I = LBound(strNms) To UBound(strNms) - 1 If
StrComp(strNms(I) , strNms(I + 1), _ vbBinaryCompare) = 1 Then tmpName =
strNms(I) strNms(I) = strNms(I + 1) strNms(I + 1) = tmpName MadeChange =
True End If Next I Wend For I = LBound(strNms) To UBound(strNms) Debug.Print I & "
" & strNms(I) Next IEnd SubLet’s break down this procedure into segments.Dim strNms(0 To 7)
As String strNms(0) = "Jerry" strNms(1) = "Candice" strNms(2) = "Brandon" strNms(3) =
"Kyle" strNms(4) = "Benjamin" strNms(5) = "Jacob" strNms(6) = "Nathan" strNms(7) =
"Olivia"The first thing we do is declare an array of strings and give each element in the array a
value.Dim MadeChange As Boolean Dim tmpName As String Dim I As Long MadeChange =
TrueNow we are setting up for the sorting portion of our routine. We want to run through the
sorting portion at least once so we set the MadeChange variable to True and then immediately
begin a While ... Wend routine.While MadeChange = True MadeChange = False For I =
LBound(strNms) To UBound(strNms) - 1 If StrComp( strNms (I), strNms(I + 1), _
vbBinaryCompare) = 1 Then tmpName = strNms(I) strNms(I) = strNms(I + 1)
strNms(I + 1) = tmpName MadeChange = True End If Next I WendThe above



section is the heart of the routine. We continue to look at each value in the strNms array and
compare it to the value in the array just after it. If the value we are looking at is alphabetically
greater than the one after it, we swap the two elements in the array and set the MadeChange
variable to True. Only after each value is examined and a swap is not made do we continue with
the next segment of our code.For I = LBound(strNms) To UBound(strNms) Debug.Print I & " "
& strNms(I) Next IThe last little segment of code prints out the elements in the strNms variable
array in their sorted condition.Come back to this procedure after we have spent a little more time
working with VBA and it will be easier to follow Sorting text is accomplished easily and quickly
using a Bubble Sort with the StrComp function.
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